
 

 Storage Conditions: -85°C to -65ºC 
(DNA controls may be separated from assay kits and stored at 2°C to 8°C) 

 
Catalog# Products Quantity 

 9-207-0101 IdentiClone T Cell Receptor Gamma Gene Rearrangement Assay 2.0 33 Reactions 
 9-207-0111 IdentiClone T Cell Receptor Gamma Gene Rearrangement Assay 2.0 MegaKit 330 Reactions 

 

 

For identification of T cell clonality. 
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1. Intended Use 
The IdentiClone T Cell Receptor Gamma Gene Rearrangement Assay 2.0 is an in vitro diagnostic product intended for PCR-based 
detection of clonal T-cell receptor gamma chain gene rearrangements in patients with suspect lymphoproliferations. 

Specifically, the T Cell Receptor Gamma Gene Rearrangement Assay 2.0 can be used to identify clonality in suspect 
lymphoproliferations. 

2. Summary and Explanation of the Test 
2.1. Background 

Rearrangements of the antigen receptor genes occur during ontogeny in B and T lymphocytes and generate products that are 
unique in length and sequence.  Polymerase chain reaction (PCR) assays can be used to identify lymphocyte populations derived 
from a single cell by detecting the unique V-J gene rearrangements present within these antigen receptor loci.1  This IdentiClone 
PCR assay employs multiple consensus DNA primers that target conserved genetic regions within the T cell receptor gamma 
chain gene and amplify the region with fluorescently labeled primers, followed by fractionation by capillary electrophoresis and 
analysis by instrument software.  This DNA based test is used to detect the vast majority of clonal T-cell populations.  Presence 
or absence of clonality can support the differential diagnosis of reactive lesions and certain T and B cell malignancies. 

This assay cannot reliably detect clonality present at less than 5% of the total lymphocyte population.  Always interpret the results 
of molecular clonality testing in the context of all available clinical, histological and immunophenotypic data. 

2.2. Summary 

This test kit consists of a single master mix that contains primers that target the Vγ2, 3, 4, 5, 8, 9, 10, and 11 and Jγ1/Jγ2, JγP, and 
JγP1/JγP2 regions, generating PCR amplicons with an expected size range between 159 and 207 nucleotides (nt).  The Specimen 
Control Size Ladder master mix targets multiple genes and generates a series of amplicons of approximately 100, 200, 300, 400, 
and 600 nucleotides to ensure that the quality and quantity of input DNA is adequate to yield a valid result.  The procedure uses 
a single thermal cycler program and similar detection methodology for all Invivoscribe Gene Clonality Assays, which improves 
consistency and facilitates cross training on a broad range of assays. 

Peak analysis is supported by a software based algorithm that calculates the relative peak height ratio (RPR) and a statistical 
parameter D(x) value for each peak.  The RPR is calculated by dividing the height of each peak to the smaller of its neighboring 
peaks and it must exceed a cutoff of 4.0.  The D(x) value is based on a variation of the Kolmogorov-Smirnov test, which compares 
two empirical distributions and determines whether they are statistically different and its value must be greater than 0.0419. 

This assay was developed by Invivoscribe.  The performance of this assay was reviewed and validated by the 
EuroClonality/BIOMED-2 Group. Euroclonality manuscript in preparation: multicenter study with 250 clinical patient specimens. 

 

  



Page 4 of 19 
 

 
IdentiClone TCRG Gene Rearrangement Assay 2.0 – ABI Fluorescence Detection  280267 Rev. G   | January 2021 

3. Principles of the Procedure 
3.1. Polymerase Chain Reaction (PCR) 

PCR assays are routinely used for the identification of clonal T-cell populations.  This test amplifies the DNA between primers 
that target conserved regions within the variable (V) and the joining (J) regions that flank the unique hypervariable antigen-binding 
region 3 (CDR3).  These conserved regions lie on either side of an area within the V-J region where programmed genetic 
rearrangements occur during maturation of all B and T lymphocytes.  The antigen receptor genes that undergo rearrangement are 
the immunoglobulin heavy chain and light chains in B-cells, and the T cell receptor genes in T- cells.  Each B- and T-cell has a 
single productive V-J rearrangement that is unique in both length and sequence.  Therefore, when DNA from a normal or 
polyclonal population is amplified using primers that flank the V-J region, a Gaussian distribution (bell-shaped curve) of amplicon 
products within an expected size range is generated.  This Gaussian distribution reflects the heterogeneous population of V-J 
rearrangements.  (In certain cases, where lymphocyte DNA is not present, no product is detected.)  DNA from samples containing 
a clonal population yield one or two prominent amplified products (amplicons) within a diminished polyclonal background. 

 
Figure 1.   This diagram of the T cell receptor gamma gene shows the approximate placement of the upstream and 

downstream DNA primers. 
Since the antigen receptor genes are polymorphic (consisting of a heterogeneous population of related DNA sequences), it is 
difficult to employ a single set of DNA primer sequences to target all of the conserved flanking regions around the V-J 
rearrangement.  N-region diversity, and somatic mutation further scramble the DNA sequences in these regions.  Therefore, a 
multiplex master mix, which targets multiple V and J regions (Figure 1), is required to detect the majority of clonal 
rearrangements.  As indicated, clonal rearrangements are identified as one or two prominent, single-sized products within the 
background of different-sized amplicon products that form the Gaussian distribution around a statistically favored, average-sized 
rearrangement. 

3.2. Fluorescence Detection 

Fluorescence detection is commonly used to resolve the different-sized amplicon products using a capillary electrophoresis 
instrument.  Primers are conjugated with a 6FAM fluorescent dye (fluorophore) so that they can be detected after excitation by a 
laser in the capillary electrophoresis instrument.  This highly sensitive detection system provides single nucleotide size resolution 
and relative quantification.  Inter and intra-assay reproducibility in size determination using capillary electrophoresis is 
approximately 1 to 2 nucleotides.  This reproducibility and sensitivity coupled with the automatic archiving of specimen data 
allows for the monitoring, tracking, and comparison of data from individual patients over time. 
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4. Reagents 
4.1. Reagent Components 

Table 1.  Available Kits 

Catalog # Description Quantity 

  92070101 IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 33 Reactions 

  92070111 IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 MegaKit 330 Reactions 

 
Table 2.  Reagent Components 

Reagent Catalog # 
Reagent Components  
(active ingredients) 

Unit 
Quantity 

92070101 
# of Units 

92070111 
# of Units 

Storage 
Temp. 

Master Mixes 22070091 

TCRG – 6FAM 
Multiple oligonucleotides targeting the 
Vγ2, 3, 4, 5, 8, 9, 10, & 11 and Jγ1/Jγ2, JγP, 
and JγP1/JγP2 regions of the T cell receptor 
gamma gene in a buffered salt solution. 

1500 µL 1 10 

 
Template 

Amplification 
Control 

  

20960021 
Specimen Control Size Ladder – 6FAM 
Multiple oligonucleotides targeting 
housekeeping genes. 

1500 µL 1 10 

Positive 
Control DNA 

40883320 
5% TCRG Positive Control DNA 
50 µg/mL of DNA in 1/10th TE solution 

50 µL 1 5 

 
or 

 

Negative 
(Normal) 

Control DNA 
40920020 

TCRG Negative Control DNA 
50 µg/mL of DNA in 1/10th TE solution  

50 µL 1 5 

Note:   There are no preservatives used in the manufacture of this kit. 

4.2. Warnings and Precautions 

   This Product is for in vitro diagnostic use. 
 Use this assay kit as a system.  Do not substitute other manufacturer’s reagents.  Dilution, reduction of amplification 

reaction volumes, or other deviation in this protocol may affect the performance of this test and/or nullify any limited 
sublicense that comes with the purchase of this testing kit. 

 Materials are stable until the labeled expiration date when stored and handled as directed.  Do not use kits beyond 
their expiration date. 

 Close adherence to the protocol will assure optimal performance and reproducibility.  Use care to ensure use of 
correct thermal cycler program, as other programs may provide inaccurate/faulty data, such as false positive and 
false negative results. 

 Do not mix or combine reagents from kits with different lot numbers. 
 Wear appropriate personal protective equipment and follow good laboratory practices and universal precautions 

when working with specimens.  Handle specimens in approved biological safety containment facilities and open 
only in certified biological safety cabinets.  Use glass distilled de-ionized molecular biology grade water for the 
preparation of specimen DNA. 

 Due to the high analytical sensitivity of this test, use extreme care to avoid the contamination of reagents or 
amplification mixtures with samples, controls or amplified materials.  Closely monitor all reagents for signs of 
contamination (e.g., negative controls giving positive signals).  Discard reagents suspected of contamination. 

 To minimize contamination, wear clean gloves when handling samples and reagents and routinely clean work areas 
and pipettes prior to doing PCR. 

 Autoclaving does not eliminate DNA contamination.  Always follow uni-directional work flow in the PCR 
laboratory; begin with master mix preparation, move to specimen preparation, then to amplification, and finally to 
detection.  Do not bring amplified DNA into the areas designated for master mix or specimen preparation. 

 Dedicate all pipettes, pipette tips, and any equipment used in a particular area to that area of the laboratory. 
 Use sterile, disposable plastic ware whenever possible to avoid RNase, DNase, or cross-contamination 
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4.4. Storage and Handling 

 For any duration other than immediate use, store assay kits at -65ºC to -85ºC. 
 The optimum storage temperature for the DNA controls is 2ºC to 8ºC, but DNA controls can also be stored at -85ºC 

to -65ºC. 
 All reagents and controls must be thawed and vortexed or mixed thoroughly prior to use to ensure that they are 

mixed completely.  Excessive vortexing may cause labeled primers to lose their fluorophores. 
 Materials are stable until the labeled expiration date when stored and handled as directed.  Do not use kits beyond 

their expiration date. 
 The PCR master mixes and controls have been validated for 6 freeze-thaw cycles with no loss in performance.  

Aliquot reagents into sterile o-ring screw-cap tubes if more freeze-thaw cycles are necessary. 

5. Instruments 
5.1. Thermal cycler 

 Use or Function:  Amplification of DNA samples 
 Performance Characteristics and Specification:  

 Minimum Thermal Range: 15 ºC to 96 ºC  
 Minimum Ramping Speed:  0.8 ºC/sec 

 Follow manufacturer’s installation, operation, calibration, and maintenance procedures. 
 See section 7.4: Amplification for thermal cycler program. 

5.2. ABI Capillary Electrophoresis Instruments 

 Use or Function:  Fragment detection and analysis 
 Performance Characteristics and Specification: 

 The following capillary electrophoresis instruments will meet the performance needs for this assay: 

• ABI 3100 Avant Genetic Analyzer (4-capillaries) 
• ABI 3100 Genetic Analyzer (16-capillaries) 
• ABI 3130 Genetic Analyzer (4-capillaries) 
• ABI 3130XL Genetic Analyzer (16-capillaries) 
• ABI 3500XL Genetic Analyzer (24-capillaries) 

 Follow manufacturer’s installation, operation, calibration, and maintenance procedures. 
 The ABI instrument used must be calibrated with appropriate Matrix Standards as outlined in section 7.2: Materials 

Required but Not Provided 
 Use the default settings for your polymer and capillary type. 
 See section 7.5: ABI Fluorescence Detection for details. 

 
  

*Warning:  These are not CE marked products 
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6. Specimen Collection and Preparation 
6.1. Precautions 

Biological specimens from humans may contain potentially infectious materials.  Handle all specimens in accordance with the 
OSHA Standard on Bloodborne Pathogens or Biosafety Level 2. 

6.2. Interfering Substances 

The following substances are known to interfere with PCR: 

 Divalent cation chelators 
 Low retention pipette tips 
 EDTA 
 Heparin 

6.3. Specimen Requirements and Handling 

This assay tests genomic DNA extracted and purified from peripheral blood, bone marrow aspirates or paraffin embedded tissue. 

6.4. Sample Preparation 

Extract the genomic DNA from patient specimens as soon as possible.  Resuspend DNA to a final concentration of 10 μg to 200 
μg per mL in 1/10th TE (1 mM Tris-HCl, pH 8.0, 0.1 mM EDTA) or in molecular biology grade or USP water.  This is a robust 
assay system.  A wide range of DNA concentrations will generate a valid result.  Therefore, quantifying and adjusting DNA 
concentrations is generally not necessary.  Testing sample DNA with the Specimen Control Size Ladder master mix will ensure 
that DNA of sufficient quality and quantity was present to yield a valid result. 

6.5. Sample Storage 

Store genomic DNA at 2ºC to 8ºC or at -85ºC to -65ºC for long term storage. 

7. Assay Procedure 
7.1. Materials Provided 

Table 3.  Materials Provided. 

Catalog # Description 

22070091CE TCRG – 6FAM 

20960021 Specimen Control Size Ladder – 6FAM 

40883320 5% TCRG Positive Control DNA 

40920020 TCRG Negative Control DNA 

 

  



Page 8 of 19 
 

 
IdentiClone TCRG Gene Rearrangement Assay 2.0 – ABI Fluorescence Detection  280267 Rev. G   | January 2021 

7.2. Materials Required (not provided) 

Table 4.  Materials Required (not provided) 

Reagent/Material 
Recommended Reagents/Materials and 
Suppliers 

Catalog # Notes 

DNA Polymerase 

Roche: 
• EagleTaq DNA Polymerase  

Invivoscribe, Inc.: 
• EagleTaq DNA Polymerase1  

or equivalent 

 
5206944190 

 
60980100 

 

N/A 

Glass Distilled De-
ionized Molecular 

Biology Grade or USP 
 

N/A N/A 
Water must be sterile and free of 

DNase and RNase. 

Calibrated Pipettes N/A N/A 
Must be able to accurately measure 
volumes between 1 µL and 1000 µL 

Thermal cycler N/A N/A N/A 

Vortex Mixer N/A N/A N/A 

PCR plates or tubes N/A N/A Sterile 

Filter barrier pipette 
tips 

N/A N/A Sterile, RNase/DNase/Pyrogen-free 

Microcentrifuge tubes N/A N/A Sterile 

Hi-Di Formamide 

Invivoscribe, Inc.: 
• HI-Deionized Formamide 

Applied Biosystems: 
• Hi-DiTM Formamide  

 
60980041 

 
4311320 

N/A 

ABI Capillary 
Electrophoresis 

Instrument 

Applied Biosystems: 
• ABI 3100, 3130, or 3500 series 

N/A N/A 

Size Standards 

Invivoscribe, Inc.: 
● Hi-Di Formamide w/ROX size standards for 

ABI 3100  
Applied Biosystems: 
• For ABI 3100 or 3130 instruments:  

o GeneScanTM - 400HD [ROX]TM 
• For ABI 3500 instruments: 

o GeneScan - 600 [LIZ]TM v2.0   

 
60980061 

 
 
 

402985 
4408399 

N/A 

Spectral Calibration 
Dye Sets 

Applied Biosystems: 
• For ABI 3100 and 3130 instruments: 

o DS-30 Matrix Standard Kit (Dye Set D)  
• For ABI 3500 instruments: 

o DS-33 Matrix Standard Kit (Dye Set G5)  

 
 

4345827 
 

4345833 

 
N/A 

Polymer 

Applied Biosystems:  
• POP-7 Polymer: 

o POP-7TM for 3130/3130XL/3500XL 
Genetic Analyzers  

 
4352759 

N/A 

1Note: This product is for sale and use in the European Economic Area only.  It is not to be resold or transferred to another party.  See also Legal 
Notice in section 15. 

  



Page 9 of 19 
 

 
IdentiClone TCRG Gene Rearrangement Assay 2.0 – ABI Fluorescence Detection  280267 Rev. G   | January 2021 

 

7.3. Reagent Preparation 

 All samples can be tested using the Specimen Control Size Ladder master mix to ensure that no inhibitors of 
amplification are present and there is DNA of sufficient quality and quantity to generate a valid result. 

 Test samples in duplicate.  If duplicate testing provides inconsistent results, re-testing or re-evaluation of the sample 
is necessary. 

 Positive, negative, and no template controls must be tested.  

7.3.1. Using gloved hands, remove the master mixes from the freezer.  Allow the tubes to thaw completely; then gently 
vortex to mix. 

7.3.2. Remove the calculated volume of each master mix to individual microcentrifuge tubes.   

 The aliquot volume is 45 μL for each reaction.   
 Add 15% overage to ensure an adequate volume is available.   
 For the TCRG – 6FAM master mix, the number of reactions (n) is: 

n  =   2 × # of samples (Run each sample in duplicate) 

+ 1 5% TCRG Positive Control DNA 

+ 1 TCRG Negative Control DNA 

+ 1 No Template Control (water) 

+ 1 Additional Reaction 

n  =   2 × # of samples + 4 Total 

 The total aliquot volume for the TCRG – 6FAM master mix is n × 45μL. 
 For the Specimen Control Size Ladder master mix, the number of reactions (m) is: 

m  =   # of samples (Run each sample in singlicate) 

+ 1 TCRG Negative Control DNA 

+ 1 No Template Control (water) 

+ 1 Additional Reaction 

m  =  # of samples + 3 Total 

 The total aliquot volume for the Specimen Control Size Ladder master mix is m × 45 μL. 

7.3.3. Add 1.25 units (or 0.25 μL @5 U/μL) of Taq DNA polymerase per reaction to each master mix.   

 Add n × 0.25 μL Taq DNA polymerase to the TCRG master mix and m × 0.25 μL Taq DNA polymerase to 
the Specimen Control Size Ladder master mix.  Gently vortex to mix. 

7.3.4. For each reaction, aliquot 45 μL of the appropriate master mix + DNA polymerase solution into individual wells 
in a PCR plate or tube. 

7.3.5. Add 5 μL of appropriate template (sample DNA, positive control DNA, negative control DNA or water) to the 
individual wells containing the respective master mix solutions.  Pipette up and down several times to mix. 

7.3.6. Cap or cover the PCR plate. 

 Samples are now ready to be amplified on a thermal cycler. 

Quick Guide 

For each master mix and n reactions, mix: 

n × 45 μL Master Mix 

n × 0.25 μL  Taq DNA polymerase 

Vortex gently to mix. 

Aliquot 45 μL of master mix + DNA polymerase solution into each reaction well. 

Add 5 μL of appropriate Template to each well. 

Total reaction volume = 50 μL 
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7.4. Amplification 

7.4.1. Amplify the samples using the following PCR program: 

 Use the calculated option for temperature measurement with the BioRad MJ Research PTC thermal cyclers. 

Table 5.  Thermal cycling conditions  

Step Temperature Duration Cycle 

1 95ᐤC 7 minutes 1 

2 95ᐤC 45 seconds 

35 3 60ᐤC 45 seconds 

4 72ᐤC 90 seconds 

5 72ᐤC 10 minutes 1 

6 15ᐤC ∞ 1 

7.4.2. Remove the amplification plate or tubes from the thermal cycler. 

 Although amplified DNA is stable at room temperature for extended periods of time, store PCR products at 
2ºC to 8ºC until detection.   

 Detection must be performed within 30 days of amplification. 

7.5. ABI Fluorescence Detection 

Please note that for ABI fluorescence detection a preceding peak is often seen and is an artifact due to the detection method the 
ABI platforms use.  Preceding peaks are sometimes skewed and have bases that slope on the right side towards the real peak.  
This is especially evident in the Specimen Control Size Ladder master mix where the 96 nucleotide (nt) peak has a preceding peak 
that shows up at 84 nt. 

ABI 3100 and 3130 Platforms: 

7.5.1. In a new microcentrifuge tube, mix an appropriate amount (10 μL per reaction) of Hi-Di Formamide with ROX 
Size Standards.  Vortex well. 

7.5.2. In a new 96-well PCR plate, add 10 μL of Hi-Di Formamide with ROX size standards to individual wells for each 
reaction. 

7.5.3. Transfer 1 μL of each reaction to the wells containing Hi-Di Formamide with ROX size standards.   

 Add only one sample per well.   
 Pipette up and down to mix. 

7.5.4. Cap or cover the PCR plate. 

7.5.5. Heat denature the samples at 95ºC for 2 minutes, then snap chill on ice for 5 minutes. 

7.5.6. Prepare a sample sheet and injection list for the samples. 

7.5.7. Run the samples on an ABI 3100/3130 capillary electrophoresis instrument according to its user manual. 

 Data are automatically displayed as size and color specific peaks.   

7.5.8. Review profile and controls, report results.  (See sections 8: Interpretation of Results and 10: Expected Values) 

  



Page 11 of 19 
 

 
IdentiClone TCRG Gene Rearrangement Assay 2.0 – ABI Fluorescence Detection  280267 Rev. G   | January 2021 

 

ABI 3500 Platforms: 

7.5.9. In a new microcentrifuge tube, mix an appropriate amount (9.5 μL per reaction) of Hi-Di Formamide with LIZ 
Size Standards.  Vortex well. 

7.5.10. In a new 96-well PCR plate, add 9.5 μL of Hi-Di Formamide with LIZ size standards to individual wells for each 
reaction. 

7.5.11. Transfer 0.5 μL of each reaction to the wells containing Hi-Di Formamide with LIZ size standards.   

 Add only one sample per well.   
 Pipette up and down to mix. 

7.5.12. Cap or cover the PCR plate. 

7.5.13. Heat denature the samples at 95ºC for 3 minutes, then snap chill on ice for 5 minutes. 

7.5.14. Prepare a sample sheet and injection list for the samples. 

7.5.15. Run the samples on an ABI 3500 capillary electrophoresis instrument according to its user manual. 

 Data are automatically displayed as size and color specific peaks.   

7.5.16. Review profile and controls, report results.  (See sections 8: Interpretation of Results and 10: Expected Values) 

7.6. Data Analysis 

The TCRG Algorithm worksheet has been developed to analyze the TCRG V2 data output. 

7.6.1. Open the TCRG Algorithm Worksheet (the worksheet requires Microsoft Excel). 

7.6.2. Add raw data files derived from CE analysis to a new project in GeneMapper software. 

7.6.3. Verify that Analysis Method selected is Microsatellite Default and that the appropriate Size Standard is selected. 

 It may be necessary to lower the Minimum Peak Height threshold in order to detect all peaks in a Gaussian 
distribution:   

 select GeneMapper Manager from the Tools menu, go to the Analysis Methods tab, open the 
Microsatellite Default Analysis Method Editor.   

 Go to the Peak Detector tab, select User Specified (rfu) toggle, and input the desired peak height for the 
Blue dye. 

7.6.4. In the Analysis menu, select Analyze. 

7.6.5. For each analyzed sample file, open the associated display plot. 

7.6.6. To ensure that only the Blue Dye is shown in the display plot, go to the View menu, select Dyes → Blue Dye. 

7.6.7. Next, in the View menu, choose Tables → Sizing Table. 

 Highlight the display plot peaks in the valid size range from 159 nt to 207 nt. 

7.6.8. In the Sizing Table, copy the Size (nt) and Height (RFU) column data for the highlighted peaks within the valid 
size range. 

7.6.9. Paste the peak size and height data into the unlocked portion of the TCRG Algorithm worksheet (cells are 
highlighted in grey).   

 GeneMapper version 3.5 and lower, requires this data to be entered manually into the worksheet. 

7.6.10. The worksheet will output a summary of RPR, D(x), and %RFU (max) for the five peaks that are the most 
significant outliers from a normal Gaussian distribution. 

 If a peak in the summary table meets the criteria for a clonal peak as defined in the TCRG Algorithm 
worksheet, it will read Yes in the column titled Significant?. 

 If a peak in the summary table does not meet the criteria for a clonal peak as defined in the TCRG Algorithm 
worksheet, it will read No in the column titled Significant?. 
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7.6.11. The following criteria, as well as those implemented in the worksheet, define peaks as Positive for Clonality: 

 Analysis using the worksheet must be accompanied by visual confirmation that the worksheet is interpreting 
the sample correctly. 

 Non-clonal samples feature a polyclonal background approximating a Gaussian distribution of peaks within 
the valid size range. Clonal samples generally feature a polyclonal background with a Gaussian distribution 
within the valid size range, from which a suspected clonal peak emerges as an outlier from the Gaussian 
distribution. 

 Shoulder peaks may accompany suspected clonal peaks. A shoulder peak is defined as a peak 1 nt upstream 
or downstream in relation to a suspected clonal peak: whose height is lower than that of the neighboring 
suspected significant peak, but higher than the background distribution. Shoulder peaks may also be 
connected to suspected clonal peaks above the baseline. Shoulder peaks are generally considered background 
and should not be evaluated as suspected clonal peaks. 

 The D(x) value of the suspected clonal peak, as calculated within the locked portion of the worksheet, must 
be ≥ 0.0419. 

 The RPR of the suspected clonal peak (calculated by dividing the suspected clonal peak height by the peak 
height of the smaller of its neighboring peaks) must be ≥ 4.0X. 

 The RFU of the suspected clonal peak must be ≥ 20% of the RFU of the highest peak in that sample. 
 If the suspected clonal peak meets these criteria (flagged by the worksheet as “Significant”), the peak is clonal 

positive. 
 There must be ≥ 2 nt difference between two clonal positive peaks. 
 Samples should be run in duplicate to confirm both replicates show positive results for a suspected peak. 
 The size of the suspected clonal peaks in both replicates must be within ± 1 nt from each other. 

7.7. Quality Control 

Positive and negative controls are provided with the kit and must be included with each assay run.  In addition, a no template 
control (e.g.  water) must also be included.  A buffer control may also be added to ensure that no contamination of the buffer used 
to resuspend the samples has occurred.  The values for the positive controls are provided under section 10.1 Expected Size of 
Amplified Products.  Additional controls and sensitivity controls (dilutions of positive controls into our negative control) are 
available from Invivoscribe. 

7.8. Assay Control 

The amplicon sizes listed in Table 4 were determined using an ABI platform.  The amplicon sizes measured on your specific 
capillary electrophoresis instrument may differ by 1 to 4 nucleotides (nt) from those listed depending on the platform of detection 
and the version of the analysis software used.  Once identified, the amplicon size as determined on your specific platform will be 
consistent from run to run.   

Note:  “Color” indicates the color of products generated with the master mix when using the default color assignment on 
ABI fluorescence detection systems. 

Table 6.  Assay Controls 

Master Mix Target Color Control DNA Cat# 
Product Size 

(nt) 
Expected 

Algorithm Results 

TCRG - 6FAM 
Vγ1-Vγ11 

+ Jγ1/Jγ2, JγP, 
JγP1/JγP2 

Blue 
Specified Size Range 
5% TCRG Positive Control DNA 

--- 
40883320 

159-207 
194, 196 

One peak at 196 nt 
flagged as 

“Significant” 

Specimen 
Control 

Size Ladder 
Multiple Genes Blue TCRG Negative Control DNA 40920020 

84, 96, 200, 300, 
400, 600a: 

N/A 

aNote:  Because smaller PCR fragments are preferentially amplified, it is not unusual for the 600 nt fragment to have a diminished signal or to 
be missing entirely.  For ABI fluorescence detection, the 600 nt peak may not appear during normal run times.  In addition, the size of 
this peak may differ by over 30 nt when fragment size is extrapolated using the GeneScan - 400HD [ROX] size standards. 
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8. Interpretation of Results 
Although positive results are highly suggestive of malignancy, interpret both positive and negative results in the context of all clinical 
information and laboratory test results.  The size range for the TCRG – 6FAM master mix has been determined to be 159 nt to 207 nt 
by testing positive and negative control samples.  However, valid clonal TCR gamma rearrangements can occur outside the specified 
size range.  Product(s) that are suspect TCR gamma gene rearrangement(s) that lie outside the specified size range can be sequenced 
to confirm their identity. 

8.1. Analysis 

8.1.1. Report samples that fail to amplify following repeat testing as “A result cannot be reported on this specimen 
because the DNA was of insufficient quantity or quality for analysis”. 

8.1.2. Repeat testing if the positive or negative control reactions fail. 

8.1.3. If samples run in duplicate yield differing results, re-test and/or re-evaluate the samples for sample switching. 

8.1.4. Examine all assay controls prior to interpretation of sample results.  If the controls do not yield the correct 
results, the assay is not valid and the samples must not be interpreted. 

Table 7.  The following describes the analysis of each of the controls, and the decisions necessary based upon the results.   

Type of Control Expected Result Aberrant Result 

No Template Control 
No amplification present: continue with 
analysis 

Amplification present:  check for 
contamination and repeat the assay. 

TCRG Negative Control 
Normal Gaussian distribution from 159 nt to 
207 nt.  No clonal peaks are flagged by 
Algorithm worksheet.  Continue with analysis. 

Algorithm worksheet flags one or more peaks 
as “Significant”: Repeat the assay 

5% TCRG Positive Control 
(This can also be an extraction 
control if positive control material is 
taken through extraction processes) 

Peaks present at 194 nt, 196 nt.  Algorithm 
worksheet flags at least the196 nt as 
“Significant.” The 194 nt peak may or may not 
be identified as “Significant”.  Continue with 
analysis. 

Algorithm worksheet does not flag peak at 
196 nt as “Significant”: Repeat the assay. 

Specimen Control Size Ladder 

If the 100, 200, 300, and 400 nt peaks are 
observed, continue with analysis.  Because 
smaller PCR fragments are preferentially 
amplified, it is not unusual for the 600 nt 
fragment to have a diminished signal or to be 
missing entirely. 

If no peaks are detected, repeat the assay 
unless specimen tests positive.  If only the 100, 
200, or 300 nt peaks are present, re- evaluate 
sample for DNA degradation unless specimen 
tests positive. 

8.2. Sample Interpretation 

Given that the controls produce expected results, interpret the clinical samples as follows: 

8.2.1. One or two significant peaks flagged by the Algorithm worksheet within the valid size range are reported as 
“Positive for the detection of clonal T cell receptor gamma chain gene rearrangement(s) consistent with the 
presence of a clonal cell population.  In the context of overall diagnostic criteria, clonal cell populations can 
indicate the presence of hematologic malignancy.” 

8.2.2. Three or more significant peaks flagged by the Algorithm worksheet within the valid size range are reported as 
“T cell receptor gamma chain gene rearrangements are consistent with the detection of biclonality or 
oligoclonality.” 

8.2.3. An absence of significant peaks flagged by the Algorithm worksheet within the valid size range is reported as: 
“Negative for the detection of clonal T cell receptor gamma chain gene rearrangement(s).” 

Note:  Conduct a visual confirmation to confirm the electropherogram and the algorithm are concordant. 
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9. Limitations of Procedure 
 This assay does not identify 100% of clonal cell populations. 
 This assay cannot reliably detect below five positive cells per 100 total cells. 
 Always interpret the results of molecular clonality tests in the context of clinical, histological, and immunophenotypic data. 
 The algorithm requires a reasonably consistent signal background and that the data is entered correctly.  Gaps in the 

background can cause the algorithm to call a sample incorrectly.  Review all electropherograms to confirm the validity of 
the interpretation. 

 PCR-based assays are subject to interference by degradation of DNA or to inhibition of PCR due to EDTA, heparin, or 
other agents. 

10. Expected Values 
10.1. Expected Size of Amplified Products 

The amplicon sizes listed were determined using an ABI platform.  Amplicon sizes seen on your specific capillary electrophoresis 
instrument may differ 1 to 4 nt from those listed depending on the platform of detection and the version of the analysis software 
used.  Once identified, the amplicon size as determined on your specific platform will be consistent from run to run.  This 
reproducibility is extremely useful when monitoring disease recurrence. 

Note:  “Color” indicates the color of products generated with the master mix when using the default color assignment on 
ABI fluorescence detection systems. 

Table 8.  Expected Size of Amplified Products 

Master Mix Target Color Control DNA Cat# 
Product Size 

(nt) 
Expected Algorithm 

Results 

TCRG-6FAM 
All V and J genes 

Vγ9, Vγ10 + Jγ1/Jγ2 

 
Blue 
Blue 

 
 

Specified Size Range 
TCRG Negative Control DNA 
5% TCRG Positive Control DNA 
 
 

--- 
40920020 
40883320 

 
 

159 - 207 
159 - 207 
194, 196 

 
 

 
No Significant Peaks 

Significant Peak at 196 nt 
and possibly second peak at 

194 nt 

Specimen 
Control Size 

Ladder 
Multiple Genes Blue Any Human DNA --- 

84, 96, 200, 
300, 400, 

600a 
N/A 

aNote :  Because smaller PCR fragments are preferentially amplified, it is not unusual for the 600 nt fragment to have a diminished signal or to be 
missing entirely.  For ABI fluorescence detection the 600 nt peak may not appear during normal run times.  In addition, the size of this peak 
may differ by over 30 nt when fragment size is extrapolated using the GeneScan - 400HD [ROX] size standards. 

 

10.2. Sample Data 

 

Figure 2.  The data was generated using the 
TCRG-6FAM Master Mix.  Amplified products 
were run on an ABI instrument. 
•  
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Figure 3.  The data was generated using the 
Specimen Control Size Ladder master mix. 

 

11. Performance Characteristics 
The assay was able to detect clonal rearrangements in eleven (11) positive control cell lines. 

Table 9.  The following well-characterized T-cell leukemia cell lines known to be positive for TCRG 
rearrangements were tested with TCRG – 6FAM master mix, and the results are shown below.  Two 
prominent peaks were detected with each of the cell lines. 

Cell Line IVS Part Number Peak One (nt) Peak Two (nt) 

100% IVS-0004 4-088-0190 178.8 187.9 

100% IVS-0005 4-088-0250 173.0 198.3 

100% IVS-0008 4-088-0430 195.1 206.7 

100% IVS-0009 4-088-0490 187.8 190.5 

100% IVS-0016 4-088-0910 169.4 193.7 

100% IVS-0021 4-088-1210 183.1 188.0 

100% IVS-0039 4-088-2290 193.9 195.9 

DND-41 N/A 168.9 188.8 

PF-382 N/A 190.6 200.1 

MOLT-13 N/A 187.9 190.6 
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Table 10.  The assay showed robust results when tested with IVS-0039 DNA (200 ng/µL) diluted into tonsil DNA (200 ng/µL) at 5%, 10%, 25%, 50% 
and 75% (v/v). 

 Peak One Peak Two 

Product Size 
(nt) 

D(x) 
Value 

RPR 
Ratio 

Significant? 
Product Size 

(nt) 
D(x) 

Value 
RPR 

Ratio 
Significant? 

5% IVS-0039 

rep 1 196.20 0.2330 6.04 Yes 194.16 0.1208 2.93 No 

rep 2 195.81 0.1803 5.32 Yes 193.75 0.0993 2.65 No 

rep 3 195.71 0.1872 6.68 Yes 193.65 0.0962 2.45 No 

rep 4 196.18 0.2080 6.34 Yes 194.09 0.0941 2.88 No 

rep 5 195.79 0.1833 6.07 Yes 193.77 0.0931 2.70 No 

10% IVS-0039 

rep 1 196.24 0.3573 9.76 Yes 194.31 0.2115 5.15 Yes 

rep 2 196.15 0.3382 9.18 Yes 193.95 0.1877 4.03 Yes 

rep 3 195.66 0.2790 8.32 Yes 193.62 0.1819 4.24 Yes 

rep 4 196.15 0.3382 9.18 Yes 193.95 0.1877 4.03 Yes 

rep 5 195.80 0.2983 7.77 Yes 193.75 0.1830 4.69 Yes 

25% IVS-0039 

rep 1 196.02 0.3947 8.00 Yes 194.16 0.3730 22.2 Yes 

rep 2 196.11 0.3216 6.07 Yes 194.17 0.3568 20.09 Yes 

rep 3 195.72 0.4059 9.39 Yes 193.66 0.3451 17.02 Yes 

rep 4 196.11 0.3212 6.07 Yes 194.17 0.3561 20.09 Yes 

rep 5 195.71 0.4316 10.24 Yes 193.65 0.3482 17.09 Yes 

50% IVS-0039 

rep 1 196.15 0.2939 4.58 Yes 194.23 0.4545 630.3 Yes 

rep 2 195.67 0.3817 7.31 Yes 193.69 0.4686 120.4 Yes 

rep 3 195.66 0.4503 9.17 Yes 193.62 0.4672 28.15 Yes 

rep 4 196.07 0.3586 5.73 Yes 194.11 0.4607 32.59 Yes 

rep 5 195.67 0.4404 8.85 Yes 193.69 0.4626 124.4 Yes 

75% IVS-0039 

rep 1 196.11 0.2387 3.36 No 193.89 0.3532 58.40 Yes 

rep 2 195.72 0.3154 5.29 Yes 193.66 0.4799 71.81 Yes 

rep 3 195.62 0.4520 9.16 Yes 193.57 0.4811 110.9 Yes 

rep 4 196.15 0.2911 4.45 Yes 194.14 0.4387 79.15 Yes 

rep 5 195.71 0.3301 5.86 Yes 193.65 0.4708 78.47 Yes 
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Table 11.  The assay, when performed in combination with the TCRG Algorithm worksheet, was capable of detecting DNA from 6 control 
cell lines (200 ng/µL) diluted into tonsil DNA (200 ng/µL) at 5% (v/v) and the results are shown below. 

 

Peak One Peak Two 

Product 
Size (nt) 

D(x) 
RPR 

Ratio 
Significant? 

Product 
Size (nt) 

D(x) 
RPR 

Ratio 
Significant? 

5% IVS-0004 

rep 1 178.87 0.2964 42.50 Yes 184.69 0.1322 5.61 Yes 

rep 2 184.36 0.1193 27.59 Yes 178.39 0.0908 21.13 Yes 

rep 3 184.32 0.1266 22.96 Yes 178.32 0.1041 23.93 Yes 

rep 4 184.69 0.1200 14.97 Yes 178.78 0.1009 29.82 Yes 

rep 5 184.36 0.1342 12.12 Yes 178.40 0.1146 32.07 Yes 

5% IVS-0016 

rep 1 169.38 0.1035 115.9 Yes 193.71 0.1016 2.32 No 

rep 2 169.03 0.0918 159.0 Yes 193.50 0.0857 2.24 No 

rep 3 168.99 0.0975 55.00 Yes 193.41 0.0791 2.25 No 

rep 4 169.38 0.1028 100.9 Yes 193.77 0.1041 2.45 No 

rep 5 169.00 0.0957 55.0 Yes 193.53 0.0944 2.50 No 

5% IVS-0021 

rep 1 187.91 0.1120 7.28 Yes 182.92 0.1239 14.57 Yes 

rep 2 187.58 0.1003 5.67 Yes 182.53 0.1298 14.23 Yes 

rep 3 182.50 0.0950 35.5 Yes 187.50 0.1110 5.54 Yes 

rep 4 187.92 0.1112 6.99 Yes 183.01 0.1238 12.68 Yes 

rep 5 187.62 0.0978 6.09 Yes 182.67 0.1253 24.69 Yes 

5% IVS-0039 

rep 1 195.97 0.2907 8.46 Yes 193.95 0.1576 3.60 No 

rep 2 195.70 0.2221 6.74 Yes 193.59 0.1321 3.04 No 

rep 3 195.56 0.2010 6.86 Yes 193.53 0.1244 2.84 No 

rep 4 196.01 0.2942 8.05 Yes 194.01 0.1484 3.18 No 

rep 5 195.71 0.2513 7.53 Yes 193.65 0.1470 3.36 No 

5% PF-382 

rep 1 191.84 0.2784 5.77 Yes 158.41 0.3057 123.5 Yes 

rep 2 191.48 0.2558 5.30 Yes 158.24 0.2739 125.7 Yes 

rep 3 191.57 0.2418 5.44 Yes 158.15 0.2787 115.1 Yes 

rep 4 191.84 0.2822 5.68 Yes 158.33 0.2811 118.8 Yes 

rep 5 191.55 0.2524 5.63 Yes 158.15 0.2883 93.0 Yes 

5% MOLT-13 

rep 1 190.74 0.2147 3.97 No 187.92 0.1292 6.96 Yes 

rep 2 190.46 0.1806 3.51 No 187.60 0.1081 4.96 Yes 

rep 3 190.46 0.1731 3.42 No 187.53 0.1039 5.27 Yes 

rep 4 190.64 0.2132 4.10 Yes 187.93 0.1215 5.69 Yes 

rep 5 190.46 0.1983 6.19 Yes 187.57 0.1114 5.80 Yes 

Note:  5% IVS-0004 is  4-088-0230, 5% IVS-0016 is  4-088-0950, 5% IVS-0021 is  4-088-1250 and 5% IVS-0039 is  4-
088-2330. 

 Using clinical samples, the TCRG V2 assay results were compared to Roche 454 sequencing for the identification T-cell receptor 
gamma gene rearrangements.  For the 454 sequencing, any DNA sequence that was present at levels greater than 5% of the total 
sequences detected was considered a clonal event.  If more than two (2) sequences exceeded the 5% threshold, that sample was 
defined as oligoclonal.  The TCRG V2 assay had 100% concordance for the seven (7) samples that were identified as clonal by 
sequencing.  There was 75% concordance for the twelve (12) samples that were either negative for a clonal event or were 
oligoclonal.  Sample types included peripheral blood, bone marrow, and FFPE samples.  It is important to note that the presence 
or absence of clonal peaks in a clinical sample does not always correlate with actual clinical outcomes. 
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12. Technical and Customer Service 
Technical and Customer Service Representatives are available Monday through Friday to answer phone, e-mail or website inquiries. 

Contact Information 
Authorized Representative and EU Technical 

Assistance 
Invivoscribe, Inc     Invivoscribe, SARL 
10222 Barnes Canyon Road, Bldg. 1 Le Forum – Bât B 
San Diego, California 92121-2711 515 Avenue de la Tramontane 
USA ZI Athélia IV 
 13600 La Ciotat, France 
  

Phone: +1 858 224-6600 Phone: +33 (0)4 42 01 78 10 
Fax: +1 858 224-6601 Fax: +33 (0)4 88 56 22 89 
Technical Service: support@invivoscribe.com Technical Service: support@invivoscribe.com 
Customer Service sales@invivoscribe.com Customer Service sales-eu@invivoscribe.com 
Website: www.invivoscribe.com Website: www.invivoscribe.com 
Business Hours: 7:00AM – 5:00PM PST/PDT Business Hours: 9:00AM – 5:00PM CET/CEST 

13. Bibliography 
1. Miller, JE, et al., An automated semiquantitative B and T cell clonality assay.  Mol. Diag.  1999, 4(2):101-117. 

14. Symbols 
The following symbols are used in labeling for Invivoscribe products. 

 For In Vitro Diagnostic Use  Expiration Date 
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 Reagent Volume  Manufacturer 

 Lot Number 
 

Consult Instructions for Use 

 Storage Conditions   
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15. Legal Notice 
15.1. Warranty and Liability 
Invivoscribe, Inc. (Invivoscribe®) is committed to providing the highest quality products. Invivoscribe® warrants that the 
products meet or exceed the performance standards described in the Instructions For Use, as to products with such an insert. If a 
product is covered by product specifications and does not perform as specified, our policy is to replace the product or credit the 
full purchase price. No other warranties of any kind, expressed or implied, are provided by Invivoscribe®. Invivoscribe® liability 
shall not exceed the purchase price of the product. Invivoscribe shall have no liability for direct, indirect, consequential or 
incidental damages arising from the use, results of use, or inability to use its products; product efficacy under purchaser controlled 
conditions in purchaser’s laboratory must be established and continually monitored through purchaser defined and controlled 
processes including but not limited to testing of positive, negative, and blank controls every time a sample is tested. Ordering, 
acceptance, and use of product constitutes purchaser acceptance of sole responsibility for assuring product efficacy and purchaser 
agreement to the limitation of liability set forth in this paragraph. 

This product is an in vitro diagnostic product is not available for sale or use within North America.  

15.2. Patents and Trademarks 

This product is covered by one or more of the following: European Patent Number 1549764, European Patent Number 2418287, 
European Patent Number 2460889, Japanese Patent Number 4708029, United States Patent 8859748, and related pending and 
future applications.  All of these patents and applications are licensed exclusively to Invivoscribe®.  Additional patents licensed 
to Invivoscribe covering some of these products apply elsewhere.  Many of these products require nucleic acid amplification 
methods such as Polymerase Chain Reaction (PCR).  No license under these patents to use amplification processes or enzymes is 
conveyed expressly or by implication to the purchaser by the purchase of this product. 

Identiclone® is a registered trademark of Invivoscribe® 

©2021 Invivoscribe, Inc.  All rights reserved.  The trademarks mentioned herein are the property of Invivoscribe, Inc. and/or its 
affiliates or (as to the trademarks of others used herein) their respective owners. 

15.3. Notice to Purchaser – EagleTaq DNA Polymerase ONLY 

This product is for sale for research use in the European Economic Area (EEA) only. It is not to be resold or transferred to another 
party.  Use of this product is covered by US Patent No. 6,127,155 and corresponding patent claims outside the US. This purchaser 
of this product may use this amount of product only for the purchaser's own internal research. No right under any other patent 
claim and no right to perform commercial services of any kind, including without limitation reporting the results of purchaser's 
activities for a fee or other commercial consideration, is conveyed expressly, by implication, or by estoppel. This product is for 
research use only. Human and veterinary diagnostic uses under Roche patent claims require a separate license from Roche. All 
uses other than internal research and human and veterinary diagnostic uses under Roche patent claims require a separate license 
from Thermo Fisher Scientific. By using this product, you acknowledge your agreement to the above. Further information on 
purchasing licenses from Roche may be obtained by contacting the Licensing Department of Roche Molecular Systems, Inc., 
4300 Hacienda Drive, Pleasanton, California 94588, USA or Roche Diagnostics GmbH, Sandhofer Strasse 116, 68305 Mannheim, 
Germany. Further information on purchasing licenses from Thermo Fisher Scientific may be obtained by contacting the Licensing 
Department of Thermo Fisher Scientific, 5791 Van Allen Way, Carlsbad, California 92008, USA 
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